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End User License Agreement (EULA)

You may not distribute, resell or share this extension to your friends, 

relatives, or strangers. Doing so will discourage further improvement of 

this extension and support for newer versions of Adobe Photoshop.

You may share this extension to members of your family including parents, 

brothers or sisters provided that this EULA is read by the recipient.
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Installation

Installing from Adobe Exchange

If installing from the zxp file, do not use Adobe Extensions Manager which was discontinued 

since 2014, to install the zxp file.

Use any of the following Adobe extension installers:

• Electron Adobe ZXPInstaller, an open source Adobe extension installer from zxpinstaller.

com

• ExManCmd command-line tool from Adobe

You may watch this video as an easy guide to the next installation steps described below..

After acquiring the extension from Adobe Exchange or installing from the zxp file, navigate to 

the following folder:

Windows—C:/Users/[Windows Username]/Downloads

Mac--/Downloads

Find the following zip file and extract it:

pixelsplasher-batch-smart-layer-replace_3.20.0210.zip

Find the following zxp file that was extracted from the zip and install it:

Pixelsplasher-Batch-Smart-Layer-Replace_3.20.0210.zxp

Verifying the Installation

After acquiring the extension from Adobe Exchange or installing from the zxp file, navigate to 

the following folder: 

Windows—C:/Program Files/Adobe/Adobe Photoshop [Version]/Presets/Scripts

Mac--/Applications/Adobe Photoshop [Version]/Presets/Scripts
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• [folder] Pixelsplasher Scripts Only

• Replace Smart Content.jsx

If the files that should have been installed are missing, manually extract them from the zxp by 

the following ways:

• Rename the .zxp file extension to .zip and open the file with the associated zip extraction 

program

• Right click the zxp file and open with any zip extraction program like 7zip or Winrar

Then copy the extracted files to the Presets > Scripts directory. For Adobe Photoshop CS5 to 

CS6, copy ”Replace Smart Content-CS6.jsx” instead of ”Replace Smart Content.jsx”.

And check if the following file were successfully installed in the “Pixelsplasher Scripts Only” 

folder:

Installing from Zip

If you received this extension directly from Pixelsplasher in a zip file, extract the 

aforementioned files to the same location mentioned in “Verifying the Installation”.
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How To Use

To access the File Options add-on, select a smart layer, then click on the menu:

Adobe Photoshop CC: File > Export > 

Adobe Photoshop CS: File > Automate > 

Then:

Smart Layer Replace...
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Adding Replacement Images

There are three ways to add replacement files.

• Select Files in the Use: dropdown menu > Click Browse button. By holding the Shift key 

you can select a range of files. By holding the Ctrl key, you can click select files or square-

select files incrementally. Your last browsed folder will be remembered.

• Select Folder in the Use: dropdown menu > Click Browse button. This will load all valid 

image files that are inside the folder that you select. The starting view is always the whole 

computer drives list.

• Click Add Open Files button. This will load all other files that are currently open in 

Photoshop.

Destination Folder

The destination folder that you set is always remembered. There are two ways to set the folder 

where to save the exported files.

Custom. Clicked the Choose... button and browse to the folder location where you want to 

save your files after smart layer replacement. If you wish to restore the destination location to 

the automatic location described below, click the Auto button which changes to Undo button 

if you wish to undo the action.

Automatic. If you have not clicked the Choose... button and selected an output destination 

folder in your computer, the output files will be saved to a sub-directory of the PSD file that 

you are working on. The output folder will be named

• /placed in [PSD file name]
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Replacement Image Options

Replacement Methods

Edit Contents. If Edit Contents is checked which is the default, smart layer content is 

replaced equivalent to using the following menu actions:

Layer > Smart Objects > Edit Contents...

With this method, the linked or embedded smart layer is opened and edited directly and 

replacement is made in the smart layer document. This is the best method of replacement for 

smart layers with warp transforms applied.

Replace Contents. If Edit Contents is unchecked, smart layer content is replaced equivalent 

to using the following menu actions:

Layer > Smart Objects > Replace Contents...

This is a faster method of replacement for smart layers with simple transforms applied. If this 

method is used on smart layers with warp or perspective transforms, the replacement image 

may not properly fill the original space occupied by the previous content due to aspect ratio 

and size difference.

Resize Methods

Crop. The replacement image is cropped in order to fill 100% of the original space occupied 

by the smart layer content while maintaining aspect ratio.
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Fit. The width and height of the replacement image are contained to best fit the original 

space occupied by the smart layer content while maintaining aspect ratio. Some unfilled space 

may show the layer behind the replacement image.

See the difference between crop and fit in this video:

https://www.youtube.com/watch?v=9tPqp7UGuUs

Custom. By default, the replacement image is transformed to 100% of its original placement 

size. You can change the Custom scale value to above or below 100%. Negative values are 

accepted. This will invert the replacement image both horizontally and vertically!

Offset Scale

Offset scale is 0% by default. This is the amount of additional scaling percentage that you 

may want applied to the replacement image. This is useful for filling unwanted spaces left out 

by smart layer content with warp or perspective transform applied, which may occur if Edit 
Contents is unchecked. Negative values are accepted. This will result in the image resizing to 

less than the overall size of the original space occupied by the smart layer content.

A. Crop resize with a 10% offset scale. B. Fit resize with a -10% offset scale.

A B
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Rendering 3D Layers

If you have selected a 3D layer and have the 3D Layer add-on (sold separately) installed, 

the Render 3D Layer option is available. This will enable rendering of the 3D object after 

replacement of its image texture is done and before the PSD is exported.

Action Buttons

OK

The OK button is enabled only if there is at least one input image available in the file list box. 

Clicking OK will run the script and apply the files included in the file list box.

Cancel

The Cancel button closes the script dialog and no other actions are taken.

Queue

The Queue button saves the current input files and closes the Pixelsplasher Batch Processor 

dialog box. You will need the Job Queue add on script installed to save the current input files 

and associated settings as a job to be run later in series with other Smart Layer Replace jobs. 

This will allow you to make smart layer replacements on multiple contents at a time.

If the Job Queue add on script is not installed, an information dialog will be displayed.
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Job Queue Add-On

$9/P$7

This is an add-on script that is sold separately and is where the Job Targets add-om is 

integrated with. All replacement jobs in the job queue are applied by Job Targets to all target 

PSD files. With the Job Queue add-on, it is possible to have several smart layer replacements 

made in each PSD target.

Job Queue has an option to separately export each layer comp in the PSD.

Job Queue demo: https://www.youtube.com/watch?v=He_dmvHEphc

Other Add-Ons

Prices are indicated as $Adobe Exchange price/P$Direct-to-author price payed via Paypal. 

Example: $9/P$7
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Job Targets Add-On

$7/P$5

This is a tab in the Job Queue window where you can load PSD and PSB files to apply the 

replacement jobs to, in addition to the starting open document where the script is running. 

You have the option to match the target smart layer contents with the replacement jobs’ 

target smart layers only, or in addition to that, apply replacement jobs that have no matching 

smart layer content in the target file to any remaining available smart layers.

Job Targets demo: https://www.youtube.com/watch?v=a4XETqBEMQ8
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3D Layer Add-On

$9/P$7

The 3D Layer add-on gives the ability of the Smart Layer Replace extension as well as the Job 

Queue add-on to replace smart layers found in texture layers of 3D objects. The extension is 

able to scan the 3D layer for textures and let you choose which one to replace. You can select 

another texture later and queue it in Job Queue.

3D Layer add-on demo: https://www.youtube.com/watch?v=4GN2qys0RqM
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3D Layer Add-On

$9/P$7

The 3D Layer add-on gives the ability of the Smart Layer Replace extension as well as the Job 

Queue add-on to replace smart layers found in texture layers of 3D objects. The extension is 

able to scan the 3D layer for textures and let you choose which one to replace. You can select 

another texture later and queue it in Job Queue.

3D Layer add-on demo: https://www.youtube.com/watch?v=4GN2qys0RqM

Layer Comps Add-On

$7/P$5

Although you are able to export all layer comps as an option in the Job Queue add-on, Layer 

Comps gives you the option to select which layer comps to include for export in addition to 

the currently selected layer comp.

Layer Comps demo: https://www.youtube.com/watch?v=e89VYIdPSVo
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File Options Add-On

$7/P$5

File Options add-on gives you the ability to customize the filenames of the exported files 

according to the format that you specify. This can be based on custom text, target PSD 

filename and the document filename. File Options add-on is open to suggestions by its users 

and you can request for a filename format option to be added that may be useful to other 

users. Up to six filename format segments can be stringed together.

In future free updates, this add-on will be further developed to include file quality options.

File Options add-on demo: https://www.youtube.com/watch?v=6aXcEhLAHvM
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How To Purchase

Prices may be slightly higher at Adobe Exchange to cover the cost of services by Adobe and 

Fast Spring. 

You can purchase add-ons directly from Pixelsplasher by sending payments to Paypal at 

https://www.paypal.me/pixelsplasher and mentioning the add-on name and the Gmail address 

to share it to with Google Drive.

Send payment of $1 less per item by buying more than one item with PPayPal.me.

Customer Support

Facebook: https://www.facebook.com/PixelsplasherDotCom/

LinkedIn: https://www.linkedin.com/company/pixelsplasher/

Email: webmaster@pixelsplasher.com

Contact Pixelsplasher if you need help making the script work according to your needs. You 

may be asked to submit your PSD file and input file.

You may also request certain features that other customers may want to use. A major feature 

may be added as a separate add on script to be sold separately.

Tutorial videos are available at the Pixelsplasher YouTube channel: https://www.youtube.com/

Pixelsplasher
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Updates

All users are entitled to free updates up to one year since date of purchase. If you have 

purchased the script at Adobe Exchange, you can download applicable updates at: https://

exchange.adobe.com/creativecloud.partner.0011O00002DWKV7QAP.html. Add-ons purchased 

at Adobe Exchange are subscription-based and may need to be renewed to continue getting 

newer version updates after one year since date of purchase.

If you have received the script via Google Drive, you can revisit the file link to check for new 

versions and download it. You may also add the file to your Google Drive folder as a shared 

file.

You may also receive update notifications in your email.


